
 

 
 

“World Class Sampled Drum Kits” 
 
 
 
 
 

USER MANUAL 
 
 
 
 

 
 
 
 
 
 
 
 

©2007 Sonic Reality Inc. 
©Ocean Way Recording 



Table of Contents 
Getting Started ……………………………………………………………………………………………………… ………. 3 
System Requirements ……………………………………………………………………………………………………… 3 
Installation / Registration .……………………………….…………………………………………………………..….. 4 
 

The Basics 
Introduction …………………………………………………………………………………………………………………… 8 
Recording and Mixing Philosophy ….………………………………………………………………………….......... 8 
Creating The Ultimate Expressive Drum Kit ……………………………………………………………………….. 9 
Opening Kontakt Player 2 ………………………………………………………………………………………………… 9 
Loading Drum Kits …………………………………………………………………………………………………………… 17 
Mix Presets …………………………………………………………………………………………………………………….. 17 
Changing Mix Presets ………………………………………………………………………………………………………. 18 
Ocean Way “Mix Preset” Philosophy …………………………………………………………………….…..………. 18 
Individual Outputs ………………………………………………………………………………………………………….. 18 
IMAP and V-Drum Formats …………………………………………………………………………………………..….. 19 
IMAP ……………………………………………………………………………………………………………………..…..…. 19 
V-Drum ……………………………………………………………………………………………………………….…..……. 20 
 

Advanced Section 
Controls …………………………………………………………………………………………………………………………. 20 
Menus 
-  Volume ……………………………………………………………………………………………………………………….. 21 
-  Panning ………………………………………………………………………………………………………………………. 21 
-  Envelope ………………………………..………………………………………………………………….……………….. 21 
-  Velocity ………………………………………………………………………………………………………………………. 22 
-  Save Settings ……………………………………………………………………………………………………………….22 
Signal Flow …………………………………………………………………………………………………………………….. 22 
Snare Mix Presets: C12A and 57 ………………………………………………………………………………………. 24 
Mixing Tips …………………………………………………………………………………………………………………….. 25 
Customizing Your Own Kits 
-  Replacing Instruments in Existing Kits ……………………………………………………………………………. 26 
-  Creating a Drum Kit from Scratch ………………………………………………………………………………….. 27 
Making and Saving Preset Changes …………………………………………………………………………….……. 28 
Assigning Discrete Outputs in ProTools ……………………………………………………………………….……. 28 
Kontakt Player 2 Optimization ………………………………………………………………………………………….. 30 
Roland V-Drum TD-20 Optimization ………………………………………………………………………………….. 31 
Switching Presets via TD-20 V-Drum Module ……………………………………………………..….…………… 33 
Audio Setup and Soundcard Settings ……………………………………………………………………..….……… 34 
Drum Replacement with Drumagog in Protools ..…………………..……..………….………………………… 38 
Credits …………………………………………………………………………………………………………………………… 44 
Ocean Way FAQ………………………………………………………………………………………………………………. 45 
IMAP Large View……………………………………………………………………………………………………………… 48 



Getting Started 
 
1.  Install Kontakt Player 2 and the Ocean Way Drums Library located on Disc 1 
 
2.  Open Kontakt Player 2 in Standalone or in preferred host. 
 
3.  Load a drum kit. 
 
4.  Use C0 and D0 on your midi controller to enjoy all the great presets. 
 
 

System Requirements 
 
Mac OS 10.4.x 
G4 1.4gHz or higher 
2GB RAM 
 
Windows XP SP2 
1.4gHz or higher 
2GB RAM  
 
OWD Gold 
DVD drive 
At least 40GB of available space on a 7200 RPM hard drive. 
 
OWD Platinum 
Available USB or Firewire 800 port. 
 
Recommended 
10,000 RPM Hard Drive 
3+ GB RAM 
 
 
 
 
 
 
 
 
 
 
 
 



Installing Ocean Way Drums 
 
Platinum Customers: 
 
Installing Ocean Way Platinum: 
 

- Run the Ocean Way Drums Platinum installer provided on the external hard drive. 
- When prompted, enter your name and serial number 
- Choose which formats of Kontakt Player 2 you would like to install.  Make sure the Platinum 

Library is checked. 
- Install Service Center so you can register your library 

 
Installing Ocean Way Gold: 
 

- Run the installer provided on Ocean Way Drums Disc 1 
- When prompted, enter you name and serial number 
- Choose which formats of Kontakt Player 2 you would like to install.  Make sure the Gold Library 

is checked. 
- You will be asked where you want install the Gold library.  If you wish to run Ocean Way 

Drums on the external enclosure, choose the hard drive as the destination.  
- Note: If you choose a subfolder on the hard drive or any other location other than the 

external drive, a new Gold folder will be made and you will be required to move the nkx files 
to the “Samples” folder of that new location. 

- Install Service Center so you can register your library 
 
Gold Customers: 
 
Installing Ocean Way Gold: 
 

- Run the installer provided on Ocean Way Drums Disc 1 
- When prompted, enter you name and serial number 
- Choose which formats of Kontakt Player 2 you would like to install.  Make sure the Gold Library 

is checked.  
- The installer will create an Ocean Way Drums folder at your selected destination.  Inside are 

the Instrument, Multi, and Samples folder.  The first NKX file is located on the first disc and 
will be installed with the library.   

- After the install is complete, drag the NKX files from discs 2-6 into the samples folder. 
 
 
 
 

 



Installation under Windows XP 
 
If this is your first KONTAKT PLAYER 2 product, then the Player will be installed with the library. If 
you already own a KONTAKT PLAYER 2 library, the Player installation will be skipped and the library 
will be installed. 
 
-  Insert the Ocean Way Drums disc into the optical drive. 
-  Use the Windows Explorer to view the contents of the disk. 
-  Start the installation by double-clicking Ocean Way Drums.exe. 
-  The setup program will suggest C:\Program Files\Native Instruments\KONTAKT PLAYER 2 as the 
path for the destination folder. You may also choose another folder. 
 
Installed Folders, Files, and Links 
 
The setup program creates a new folder called KONTAKT PLAYER 2 in the installation directory 
(Program Files\Native Instruments). This folder contains the files required to operate the software. If 
you do not choose a different program path during installation, links to KONTAKT PLAYER 2 and a 
ReadMe file are added to the Start menu under Programs\Native Instruments. 
 
Important: Do not move the installation folder to another location! 
 
VST, DXi, and RTAS Plug-in Installation 
 
When the choice is given by the installer, tick the correct plug-in from the list of components to 
install. 
 
For VST, you can choose to automatically search for the VST plug-in folder, or manually select the 
VST plug-in folder of your choice. Please select the option that best suits your installation 
requirements. 
 
If you decide to install the VST plug-ins at a later date, simply copy the "KONTAKTPlayer2 VST.dll" 
from the VST folder of the installation folder into the VST plug-ins folder of the host program. 
 
Note: If the VST plug-ins are not visible in the Windows Explorer, select the Show All Files option. 
This option is located in the Explorer menu View -> Folder Options...on the View tab below Hidden 
files. Optionally, you can set up your host programs so that they all use the same VST plug-ins folder. 
 
Updating 
 
Be sure to check the Native Instruments web site http://www.native-instruments.de for any possible 
KONTAKT PLAYER 2 updates that have occurred since the time your software was manufactured. 
Software is frequently updated and a more recent version may be available. Library updates may be 



available at the Ocean Way Drums website.  Please check the Library Info box (Browser) for relevant 
links. 
 
After the library has been installed, it needs to be registered. You are given a 30-day grace period for 
each library before registration is required, but it is recommended that you register as soon as 
possible. Information on the registration procedure is given below.  
 
 

Installation under Mac OS X 
 
If this is your first KONTAKT PLAYER 2 product, then the Player will be installed with the library. If 
you already own a KONTAKT PLAYER 2 library, the Player installation will be skipped and the library 
will be installed. 
 
-  Insert the Ocean Way Drums disc into the CD/DVD drive of your computer. 
-  Double-click the installation program “Ocean Way Drums Installer” to start it. 
-  The start screen appears first. After clicking Continue and confirming the license agreement, a 
window opens where you can select the installation location and the destination folder.  
 

Installation Type 
 
Easy Install 
 
The easy install method installs all components of the software. This includes, but is not limited to, 
the standalone application, all plug-in versions, and documentation. In most cases, you will want to 
use the easy install method. 
 
Custom Install 
 
You also have the option to perform a custom installation of your software. This is practical in two 
situations: 
 
1.  You want to (re)install just one or more items without installing everything again. If this is the 
case, check only the necessary boxes. 
 
2.  You know that you do not need certain items to be installed. In this case, leave the necessary 
items unchecked. 
 

Updating 
 
Be sure to check the Native Instruments web site for any possible KONTAKT PLAYER 2 updates that 
have occurred since the time your software was manufactured. Software is frequently updated and a 



more recent version may be available. Library updates may be available at the Ocean Way Drums 
website.  Please check the Library Info box (Browser) for relevant links. 
 
After the library has been installed, it needs to be registered. You are given a 30-day grace period for 
each library before registration is required, but it is recommended that you register as soon as 
possible. Information on the registration procedure is given below. 
 

Authorizing the Library 
 
After installing the library, it will run in demo mode (also called a grace period) for 30 days. When 
you launch KONTAKT PLAYER 2, in the Browser you will see a little caution icon to the left of the 
library title.  
 
Yellow means the library is running in demo mode.  
 
After a library has been properly registered, the caution icon disappears entirely. 
 
Red means the demo period has expired and the library can no longer be used until it has been 
registered. The red icon may also appear if the system ID of the computer changes due to new 
hardware components (CPU, motherboard, etc.) If this occurs, the library will need to be re-
registered.  
 
To authorize the library, you should use the Native Instruments Service Center application, which was 
installed along with the KONTAKT PLAYER 2 software. You can start Service Center through the Info 
box registration tab. For more information on how to use Service Center please see the 
accompanying documentation in the Service Center application folder. 
 

 
 
 
 
 
 
 
 
 



The Basics 
 
Introduction  
 
Thank you for purchasing Ocean Way Drums for world class sampled drum kits in software. Ocean 
Way Drums is the brainchild of studio owner Allen Sides, one of the audio industry’s most esteemed 
figures. The concept is simple – make the sound of Ocean Way, the world’s most awarded studio 
complex, available to artists who are serious about their music. Ocean Way Drums provides you with 
19 kits, each with 12 presets in both snare on and snare off versions. The Platinum version also 
includes 7 additional kick drums.  The presets instantly provide a wide variety of spatial depths. And 
for those who want to experiment, adjustments to the individual instrument faders and stereo sub 
mixes offer unlimited possibilities. Imagine booking time in one of the world’s most revered rooms, 
using the best sounding drums and then having multi platinum engineer/producers record and 
balance your session. Ocean Way Drums can help your music sound like a million bucks. 
 
Recording and Mixing Philosophy 
 
Standard drum miking (mic choice and position) in most recording sessions is a compromise that has 
developed because of a need to get the most isolation not only between the various drums and 
cymbals within a drum set, but to isolate all the drum tracks from loud sound sources being recorded 
in the studio at the same time. Since obviously no other instruments were being recorded for the 
Ocean Way Drums sessions, we chose to record each instrument at the optimal distance and angle 
and with the microphones that best captured the full frequency and dynamic range of that 
instrument.  
 
Kick   AKG® D12, AKG D112, Neumann® U47 Fet 
Snare Top  AKG® C12A, Shure® SM 57 (custom) 
Snare Bottom Sony® 55P 
Hi Hat  Sony® 55P 
Toms   AKG® C12A 
Overheads  AKG® C12 
Rooms  Neumann® M50, Neumann® KM 54, Telefunken® U47 
 
And Because of the unique way Ocean Way Drums was recorded, each individual drum and cymbal is 
100% DISCRETE from every other instrument. Not only does this enable you to infinitely customize 
the existing kits and create brand new kits to fit your needs, you have TOTAL independent control 
over the various mono and stereo sound sources for each of the individual instruments. 
 

 
 
 



Creating The Ultimate Expressive Drum Kit 
 
Ocean Way Drums incorporates Sonic Reality’s proprietary I-Map™ technique, which was created to 
enable highly expressive and natural performances utilizing a MIDI keyboard. And, in addition to the 
I-Map™, a separate, state of the art map was created just for Roland® V-Drum users. We hope that 
these features, along with extraordinary natural room ambiance, high resolution audiofile sound and 
extended flexibility will provide you with inspiring musical experiences.  
 
The following portion of the manual provides an overview of how to quickly and simply use Ocean 
Way Drums right out of the box. For more information on how to tweak the mixes and make your 
own custom drum kit combinations, please see the ADVANCED section of this manual.  
 

Opening Kontakt Player 2 
 
Standalone Use 
 
Standalone operation is ideal for situations in which KONTAKT PLAYER 2 is the only audio software 
you need to run on the computer, for example, in a live performance situation in which you have all 
your patches loaded and wish to call them up for use individually. 
 
To use KONTAKT PLAYER 2 as a standalone application, go to the Program Files or Applications 
folder and launch KONTAKT PLAYER 2. When you do this, KONTAKT PLAYER 2 communicates directly 
with your computer's audio and MIDI hardware interfaces. 
 
Plug-in Use 
 
Used as a plug-in, KONTAKT PLAYER 2 is not a standalone program, but rather a "module" that can 
be used within a host sequencer. While standalone mode is often useful when KONTAKT PLAYER 2 is 
all you need, plug-in mode is more useful when sequencing, or when other plug-ins may be in use. 
For example, in a sequencing environment you may wish to record 16 channels of KONTAKT PLAYER 
2 instruments then combine them with other audio or MIDI tracks and create a mix. Plug-in operation 
provides other benefits such as: 
 
-  MIDI sequencing of KONTAKT PLAYER 2 and audio mixdown of the MIDI tracks within a single 
program 
-  Comfortable automation of KONTAKT PLAYER 2 parameters in the host sequencer 
-  Further processing of KONTAKT PLAYER 2 signals using additional plug-ins 
-  Restoring of all plug-in settings when the host sequencer recalls a project 
-  Integration with other instruments into a "virtual studio" 
 
We will now describe the procedures involved in using KONTAKT PLAYER 2 inside each of the major 
host sequencers on both Macintosh and PC. 
 



Native Instruments Kore 
 
Launch Kore 
 
Locate the Browser. If it is not visible, open it and select the Plug-ins tab.  
 
Note the View tabs labeled Instruments and Effects. Choose KONTAKT PLAYER 2 from the list and 
drag it to the rack (empty space above the browser).  
 
This will create a new Sound layer which includes KONTAKT PLAYER 2. Click on the Sound layer tab 
to open the interface for editing, e.g. add more instruments or send effects, assign controls, and thus 
begin designing your Sound layer. 
 

 
 
KONTAKT PLAYER 2 now appears in the instrument slot and is ready to use. The instrument mixer 
channel will allow you to mix, pan, and process the software's output. 
 
If the Instrument interface is not already open, press the E button in the assignment panel to call up 
the KONTAKT PLAYER 2 interface. Here you can control and edit all the features and functions that 
the product has to offer. 
 
After loading an Instrument, you should be able to trigger it via MIDI using a keyboard controller. 
KONTAKT PLAYER 2's sound will generate through Kore and directly to your sound card. If the plug-
in does not receive MIDI or generate audio, then make sure to check the following areas: 
 
Open the Setup menu>Audio MIDI settings dialog. Select the MIDI tab and make sure your MIDI 
device shows up and is ON. 
 
Check the channel's MIDI filter settings. Make sure that the MIDI channel is set to receive on the 
channel which your keyboard sends.  
 

Cubase and Nuendo by Steinberg 
 
Launch Cubase, go to the Devices menu option and select the VST Instruments menu option or press 
F11 on your keyboard. 
 
A window showing the instrument rack appears. Click on an empty slot and choose KONTAKT 
PLAYER 2 from the available list of instrument plug-ins. 



 

 
 
KONTAKT PLAYER 2 will now appear in your list and automatically be turned on. It will also create a 
set of audio channels in your VST mixer that will be used for mix down within your project. This will 
allow you to mix, pan, and process KONTAKT PLAYER 2's output just like any other existing audio 
track in your Cubase song. 
 
Click on the Edit (e) button to call up the KONTAKT PLAYER 2 interface. Here you can control and 
edit all the features and functions that KONTAKT PLAYER 2 has to offer. 
 
Now go to the Project page and add a MIDI track (if you do not have one already created). 
 

 
 
In the Inspector, go to the Output parameter section for this MIDI Track and click on the field. This 
will show a list of available MIDI out ports to assign to this MIDI track. Choose KONTAKT PLAYER 2 
from the list. 
 
Note: If a product does not appear in the list of available VST instruments, then you may need to 
enable it manually via the Devices/plug-in information window. If the product does not show up 
there, then it may not be installed correctly. Please refer to the previous section on installing the 
plug-in for both Windows and Mac platforms for more assistance on setting this up. 
 
After having loaded KONTAKT PLAYER 2 from the library, you should be able to trigger it via MIDI 
using a keyboard controller. KONTAKT PLAYER 2's sound will generate through the VST mixer and 
directly to your sound card. If the plug-in does not receive MIDI or generate audio, then make sure 
to check the following areas:.  
 
The MIDI channel of your MIDI track must correspond to the receive channel of the loaded 
instrument. 
 
Make sure that you have properly configured your sound card for use with Cubase/Nuendo. 
 



You may also want to refer to the Cubase/Nuendo manual which offers additional instruction in using 
virtual instruments and plug-ins within a Cubase/Nuendo project. 
 

Apple Logic Pro and Logic Express 
 
Launch Logic and create an audio instrument track or set an existing audio or MIDI track to an audio 
instrument track by clicking on the track name, holding down the mouse button and choose Audio -> 
Audio Instrument -> Inst 1. 
 

 
 
Double click the audio instrument track to open the environment window. Logic scrolls automatically 
to the first instrument bus in the Logic mixer. 
 
Choose the KONTAKT PLAYER 2 plug-in in the appropriate insert slot of the instrument track, either 
in the arrange or mixer window. To do so, click onto the insert slot, hold down the mouse button and 
choose Stereo -> Audio Units -> Native Instruments -> KONTAKT PLAYER 2. (KONTAKT PLAYER 2 
can also be used as a multichannel instrument.) 
 

 
 
 
The plug-in now appears in the instrument slot and is ready to use. The instrument mixer channel 
will allow you to mix, pan, and process the software’s output just like any other existing audio track 
in Logic. 
 
If the KONTAKT PLAYER 2 interface is not already open, double click on the mixer’s insert slot to call 
up the KONTAKT PLAYER 2 interface. Here you can control and edit all the features and functions 
that the product has to offer. 
 
After loading an Instrument, you should be able to trigger it via MIDI using a keyboard controller. 
KONTAKT PLAYER 2's sound will generate through the mixer and directly to your sound card. If the 
plug-in does not receive MIDI or generate audio, then make sure to check the following two areas: 
 
Make sure the Instrument track is selected / record enabled in the Arrange window. 
The MIDI channel of your MIDI track must correspond to the receive channel of the loaded 
instrument. 
 
Make sure that you have properly configured your soundcard for use with Logic. 
 



You may also want to refer to the Logic manual which offers additional instruction in using virtual 
instruments and plug-ins within a Logic project. 
 

MOTU Digital Performer 
 
Launch Digital Performer and create an instrument track by selecting Project -> Add Track -> 
Instrument Track -> KONTAKT PLAYER 2.  
 
 

 
 
Create a MIDI track by selecting Project -> Add Track -> MIDI Track. In Digital Performer's track 
overview window (or in the sequence editor window) assign the output of this MIDI track to 
KONTAKT PLAYER 2 and a MIDI channel. 
 
The plug-in is now ready to use. The mixer of Digital Performer will allow you to mix, pan, and 
process KONTAKT PLAYER 2's output just like any other existing audio track.  
 

 
 
To play KONTAKT PLAYER 2 with your keyboard, record-enable the MIDI track which you have 
routed to KONTAKT PLAYER 2 and make sure MIDI Patch Through is enabled in the Studio menu of  
Digital Performer. 
 
After having loaded an Instrument, you should be able to trigger it via MIDI using a keyboard 
controller. KONTAKT PLAYER 2's sound will generate through Digital Performer's mixer and directly to 
your sound card. If the plug-in does not receive MIDI or generate audio, then make sure to check the 
following areas: 



 
-  Make sure MIDI Patch Through is enabled in the Studio menu of Digital Performer. 
-  The MIDI channel of your MIDI track must correspond to the receive channel of the loaded 
instrument. 
-  Make sure that the instruments track output is correctly set. 
-  Make sure that you have properly configured your sound card for use with Digital Performer. 
 

Apple GarageBand 
 
Launch Garage Band 
 
Press the “+” button to create a new “Software Instrument” Track. From here you can choose the 
icon you wish to use. 
 
Double-click the instrument track icon or press the “I” icon to get the Track Info. 
 
From the Info window expand the Details triangle underneath the Instrument icon to expose the 
track settings. 
 
From the Generator drop-down menu, choose KONTAKT PLAYER 2 from among the Audio Unit plug-
ins. 
 

 

 
 
Clicking on the pencil icon next to the “Manual” drop-down menu will open the KONTAKT PLAYER 2 
interface for editing. 
 
KONTAKT PLAYER 2 can now be played using an external MIDI keyboard. 
 

Cakewalk Sonar 
 
Launch Sonar 
In the synth rack choose KONTAKT PLAYER 2 DXi 2. 
 



 
 
Route a MIDI track to the DXi 2-Plug-in by selecting KONTAKT PLAYER 2 in the Out drop down list. 
 

 
 
After having loaded an Instrument from the library you should be able to trigger it via MIDI using a 
keyboard controller. KONTAKT PLAYER 2's sound will generate through Sonar's mixer and directly to 
your sound card. If the plug-in does not receive MIDI or generate audio, then make sure to check the 
following areas: 
 
-  Make sure MIDI Patch Through is enabled in the Studio menu of Sonar. 
-  The MIDI channel of your MIDI track must correspond to the receive channel of the loaded 
instrument. 
-  Make sure that the instruments track output is correctly set. 
-  Make sure that you have properly configured your sound card for use with Sonar. 
 

Digidesign Pro Tools 
 
Launch Pro Tools. 
 
Create a new Instrument track by choosing New Track from the File menu. 
 
Locate the channel mixer Window -> Mix 
 
The dark grey box at the topmost section of the Instrument channel is the RTAS insert section. Click 
on the first empty slot to show all available RTAS plug-ins.  
 
Choose KONTAKT PLAYER 2 from the multi-channel RTAS plug-in > Instrument menu 
 



 
 
To open the plug-in interface for editing, click once on the insert slot. 
 
After having loaded an Instrument, you should be able to trigger it via MIDI using a keyboard 
controller. KONTAKT PLAYER 2's sound will generate through the mixer and directly to your sound 
card. If the plug-in does not receive MIDI or generate audio, then make sure to check the following 
areas: 
 
-  A physical input may need to be assigned to the instrument track. 
-  The Instrument track fader (Mix window) may be down. 
-  The instrument track in not selected in the Edit window. 
 

 
 
 
 
 
 
 
 
 
 
 



Loading Drum Kits 
 
If you look at the Ocean Way Library in the browser of the Kontakt Player, you will see a drop down 
menu called “Multis”. A “Multi” in Ocean Way Drums is a complete drum kit made up of individual 
instruments per drum of the kit. To load up a kit simple select one of the 19 multi kits from the 
browser and drag it to the right into the Kontakt Player instrument window. It may take a moment to 
load because Ocean Way Drum kits are very large in size because of their high-resolution fidelity and 
flexible mixing control.  
 
You may notice that there are two versions of each kit that are labeled 57 and C12A. The multis that 
have “57” are mixes done with a mono Shure® SM57 as the direct mic over the snare without a mic 
underneath the drum. The multis that have “C12A” in the name use a special stereo pair of vintage 
tube AKG® C12s as the direct mics over the snare in addition to a stereo pair of Sony 55P mics 
underneath the drum. This is a miking technique developed exclusively for this library. For more 
information on the proprietary extra mic mixing options of Ocean Way Drums check out the videos on 
http://www.oceanwaydrums.com  
 
There are also variations of each kit with “Snare On” or “Snare Off”. This refers to the bottom snares 
of the snare drum being in on or off position so the user can choose whether they want the natural 
rattling of the snares when the toms and kick are played or if they would prefer the snares off which 
offers a more pure and clean sound only achievable through advanced sampling.  
 
If you are playing from a keyboard you will want to choose multis in the “IMap” set of multis and if 
you are playing from drum pads such as the Roland® TD-20 V-Drums then you would choose the 
“VDrum” set of multis. For more information about I-Map and V-Drum Map please refer to “Tour of 
the Library” in the Basic section of this manual.  
 
Multi’s are made of instruments, which can all be separately located in the Menu “instruments” 
directly next to the “mulits” drop down menu in the Kontakt Player’s browser. 
 
For information on customizing your own kits with different combinations of drums, refer to “Creating 
Your Own Kits” in the Advanced section of this manual. 
 

Mix Presets 
 
Ocean Way Drums provides six Mix Presets for each Drum Kit Multi and its individual drum 
instrument components. They consistently go from dry (1) to ambient (6).  These easy to use pre-
done mix presets were specially balanced by Allen Sides and Steven Miller at Ocean Way Studios to 
give you the professional sound of Ocean Way right out of the box. This feature is unique to Ocean 
Way Drums as you not only have full control of the mix yourself but a “helping hand” from top 
engineer/producers as well. 
 



For information on making your own mixes, refer to “Creating and Saving Your Mixes” in the 
Advanced section of the manual. 
 
The preset menu is located on the top right corner of every instrument and labeled P1-P6. (see 
below) 
 

 
 

Changing Mix Presets 
 
Changing mix presets on every instrument individually with a mouse is possible but we felt it was 
much too time consuming, so it has also been programmed so that all of the instrument’s preset 
mixes in a multi can change together via simple up and down “key switching”. Keys C0 and D0 on a 
connected midi controller were designed to scroll through the six mix presets when using the I-Map 
kits. By hitting D0 it scrolls up through the mix presets and by hitting C0 it scrolls down. For the V-
Drum Map kits the + and – keys on the TD-20 brain will cycle up through your mix presets if your a 
V-Drum user. 
 
Warning:  It’s important to know that when preset mixes are switched there is a lot of data 
changing all at once. DO NOT change presets in the middle of a performance.  Doing so can cause 
the Kontakt Player to crash.  Wait for your voices to reach zero, and then proceed with the preset 
change. If you do crash the Kontakt Player simply save a back up of your session and restart the 
program. Sometimes it is necessary to restart your computer. 
 

Ocean Way “Mix Preset” Philosophy 
 
These MIX PRESETS enable you to easily audition a variety of spatial settings for your drum track. 
We encourage you to use these as starting points and customize not only the balances within each 
instrument and between the instruments that comprise the drum set (K, Sn, H, Toms, Cymbals), but 
mix and match instruments from one set with ones from others. If you want more of room mic 2 on 
the snare, less of room mic 3 on the kick and no room mics at all on the hi hat, you can easily 
achieve that by tweaking the individual instruments. Remember also that pitch and envelope are 
adjustable for each instrument (on the instrument level), as well as any of the available effects at the 
output buss level. 
 



In addition to the six mix presets for each drum set, we offer a second snare instrument with more 
mix presets. Because of the unique way we recorded the snare drum, there are 12 distinct mic 
combinations between the 57 and C12A options that provide a wide amount of tonal variations. 
These 12 combinations are shown in the “Advanced” section under the heading “Snare mix presets: 
57 and C12A”.   
  

Individual Outputs 
 
If you are using Ocean Way Drums in a sequencer, by default, all of the submixes are being routed 
to your stereo bus.  In some sequencers, each submix (ie. snare, amb.) can be routed to individual 
tracks for discrete mixing and processing.  For more information on this and other output assignment 
options, refer to the Advanced Output section of the manual. 
 

IMAP and V-Drum Formats 
 
I-MAP 
 
I-MAP is a proprietary MIDI note mapping/drum kit layout scheme developed by Sonic Reality that 
facilitates improved live performance of drum kits via MIDI keyboard input. I-MAP places drums in 
their most flexible and intuitive position, allowing each of the fingers on both hands independent and 
coordinated control over the loaded kit. With very little practice, it is possible to lay down complete 
drum grooves in a single take that have incredible feel and groove.  Having Ocean Way Drums 
mapped over the I-MAP gives the user an amazing amount of versatility and creativity having 
dedicated keys for rolls, ghost notes, cymbal swells and alt hits just to name a few. 
 

 
(For a larger view of the IMAP please see pg. 41) 
 
Note:  Kit 18 Snare contains no Edge, Ghost Notes, Rolls, and alts. 
 



 
V-Drum 
 
The V-Drum Instruments and Multis have been carefully programmed to work with the Roland TD-20 
Brain.  All the kits have been designed with a four Tom set in mind.  Just like a real kit you have 
center, edge and rim hits all programmed with a multitude of samples for great dynamic range and 
playability.  The only difference between the IMAP and V-Drum kits is that no extra hits or rolls have 
been added to the V-Drum patches virtually keeping the characteristics of a real drum kit. 
 
Snare On and Snare Off 
 
Ocean Way Drums contains a separate snare on, and snare off version of each kick and tom.  The 
snare off versions have no “rattling snares” present in the kick and toms, allowing you to hear only 
the instrument as cleanly as possible.  The snare on versions, contain the natural snare rattle in the 
signal, giving it that big sound that sounds great when together with the rest of the kit. 
 
 

Advanced Section 
 
 

Controls  
 

 
 
Ocean Way Drums offers deep levels of control over each drum in kit. Since each drum has its own 
instrument within a Multi you can adjust the mix and a variety of sound shaping parameters PER 
DRUM which gives you tremendous flexibility for getting an unlimited range of sounds tailored just for 
your music. Different panels of knobs show up depending on what is selected in the top left corner of 
the instrument. The first one is “Volume” which gives you the individual volumes of the multi-channel 
mics of the kit. In Ocean Way Drums we offer more mic mixing options than you normally get in 
multi-channel drum products. Remember that you can always just use the Mix Presets in the upper 



right corner if you want “easy ready to play” mixes. But if you want to adjust the individual levels of 
the mics to get your own balance you can do so in the volume panel of knobs. Other panels include 
Panning for adjusting the panning of the mics of the drum and Envelope which allows you to adjust 
the attack and release of drum mics. Velocity gives you a global control of the dynamic response of 
the drum.  
 

Menus 
 
Volume 
 

 
 
Here you have complete volume control over every microphone.  When the volume is turned all the 
way down, the voice group is turned off and no polyphony is being used. 
 
Panning 
 

 
 
Pan settings for every microphone.  Fine tuning the image of what you might want to hear as the 
drummers’ perspective is practical example.  Instruments like the snare will offer you infinite 
possibilities when it comes to sonic placement. It is important to note that changing a preset within 
drum sets will NOT alter the panning you currently have for any individual instruments. 
 
 
Envelope 
 

 
 
The primary practical application of envelope in Ocean Way Drums is to shorten the duration (or 
release) of sound sources. Within each individual instrument, we provide the ability to separately 
control the release of both the direct and the ambience signals. 
 



 
 
Velocity 
 

 
 
Velocity to amp amount allows you to make an instrument more or less dynamic.  We set the default 
velocity to an overall setting that should work well with all keyboard controllers. You will not only find 
optimum settings for your controller, but adjust velocity for each individual instrument depending on 
the musical dynamics you are trying to achieve.  
 
Save Settings 
 

 
 
Navigate to this save menu after you have made changes to a preset.  See the “Making and Saving 
Changes” instructions in the “Presets” section below for more detailed information on saving. 
 

Signal Flow 
 
The signal flow hierarchy of Ocean Way Drums is as follows:  
  
The highest level of control is the INSTRUMENT Level. This is where you control volumes, pans, 
envelope and velocity not only for each individual instrument, but for the various mono and stereo 
sound sources within each instrument.  
 
The various sound sources from each INSTRUMENT are routed to stereo OUTPUT BUSSES. 
 

 



 
The direct (close) mics and any Thwak signal (a compressed signal) for each specific instrument are 
routed to busses with that instrument name (Kick, Snare, Hat, Toms). The stereo Overhead signal for 
all instruments is bussed to the OVERHEAD buss. The 3 stereo Room mics and any RMX (an 
ambience signal) for each specific instrument are routed to the Ambience buss. 
 

 
 
The one exception to this is the cymbals. The “Direct” signals for the cymbals (Ride and Crashes) 
ARE the Overhead microphones. This is important to remember because the level of the cymbals is 
mixed to the OH output buss along with the OH level from all other instruments. Keep this in mind 
when you want to change the volume of the cymbals. If you choose to raise or lower the cymbal 
levels at the OH output bus, you are also raising or lowering the OH signal for all the other 
instruments. 
 
It is important to be conscious of the levels you are sending to the individual output busses. Once 
you see signal consistently in the red on any of the busses, you will be creating digital distortion. 
 



On each Output buss you can insert Kontakt Player 2’s compressors, limiters, eq, reverb, delay, 
chorus, flanger, phaser, and distortion.  The image below shows how, and where to add these 
effects. 

 
 

Snare Mix Presets: C12A and 57  
 
The microphones used are two C12A’s about eighteen inches above the drum head, two custom 57’s 
two inches from the head, and two 55P’s five inches under the bottom head.  
 
Because there are so many variations, the two snare Pre Sets represent the opposite ends of the 
sonic spectrum. The “C12A” versions utilize both C12A’s in stereo (panned hard left and right) along 
with both under snare mics in stereo (also panned hard left and right). The “57” versions utilize one 
or the other custom 57 in mono without under snare mics. Many of the Pre Sets for both the “C12A” 
and “57” versions do include some amount of “Thwack” (which is explained below). 
 
Here is a list of the 12 different mic combinations that we suggest you experiment with 
 
Version “C12A” 
Stereo C12A’s (L & R) with Stereo under snare mics (L & R)   C12A Preset 
Stereo C12A’s (L & R) with Mono under snare mic (C) 
Mono C12A (C) with Stereo under snare mics (L & R) 
Mono C12A (C) with Mono under snare mic (C) 
Stereo C12A’s (L & R) with no under snare mics 
Mono C12A (C) with no under snare mic 
 
Version “57” 
Stereo 57’s (L & R) with Stereo under snare mics (L & R) 
Stereo 57’s (L & R) with Mono under snare mic (C) 
Mono 57 (C) with Stereo under snare mics (L & R) 
Mono 57 (C) with Mono under snare mic (C) 



Stereo 57’s (L & R) with no under snare mics 
Mono 57 (C) with no under snare mic      57 Preset 
 
As noted in the section on panning, changing a preset within drum sets will NOT alter the panning 
you currently have for any individual instruments. This is most important when dealing with different 
snare mic combinations. The stock panning on the C12A’s and Under mics are hard left and right 
while both 57’s are panned in the center. When experimenting with any other configuration (ie: 
adding mono under snare to mono 57, using just one mono C12A, stereo 57’s, etc), you must 
manually adjust the pan positions. 
 

 
 
 
Mixing Tips 
 
-  Each of the top and bottom mics will have a slightly different sound from each other so when you 
use in mono, listen to both to determine which fits your needs 
 
-  When using the mics in stereo mode, pan them either all the way L & R or wherever you would like 
 
- You can easily switch between 57 and C12A presets on the snare instrument no matter what 
version of the drum set you have loaded 
 
-  You may want to experiment with the “Thwak” tracks. Thwak is a highly compressed mic signal to 
be added to your dry, uncompressed drums. It is not meant to be used by itself. It can add weight 
and power to your sound without adding extra attack. 
 
-  There is also an ambience track called RMX. This is a return (from the snare) of a vintage AMS 
RMX 16 Reverb unit on the “Non Lin” setting. This is the sound that defined many important records 
of the 80’s and is highly identified with artists like “Phil Collins.” While it is a very specific sound when 
prominent, it can be useful when tucked in with the other signals. 
 
- Thwack and RMX tracks are also included on many of the Kick drums. And while we don’t provide 
alternate Pre Sets for the kicks, there are often 2 close mics (AKG D12/D112  and Neuman 47Fet) 
that can be used either separately or blended together. On the others, there is only one mic that we 
felt worked best for that particular drum. 
 

Customizing Your Own Kits 
 



There may be a time when you want to create your own drum kit from scratch, or simply replace an 
instrument in an existing drum kit. 
 
Before you start building your kit… 
 
-  Click the  button. 
 
-  Click on the “Handling” Tab and choose “Assign to Omni” as shown below. 
 

 
 
This will assign all the new Instruments you are about to bring in to “Omni” mode.  If this is not 
chosen, every new instrument will have different midi settings, making it a problem when playing 
back from your V-Drums or midi controller. 
 
-  Open up the “Output Multi” located in the “Multi” folder.  This will load the correct outputs.  If you 
do not load this and start building your kit, you will find many of your instruments will not be heard. 
 
Replacing Instruments in Existing Kits 
 
-  Click on the instruments tab as shown below. 
 

 
 



-  Choose IMAP or V-Drum in your browser. 
 
-  After choosing IMAP or V-Drum, the instruments folders will be displayed. 
 

 
 
-  Inside each of these folders are the individual instruments from each kit. 
 
-  To replace your old instrument with the new one, simply drag and drop the new instrument from 
your browser directly on top of the instrument you want to replace. 
 
Note:  Keep in mind that if you double click on the instrument, or drag it into empty space in 
Kontakt Player, it will not replace, but instead add it to the multi. 
 
-  If you wish to save you changes,  

 
Creating a Drum Kit from Scratch 
 
-  Click on the instruments tab as shown below. 
 

 
 
-  For a more convenient way to access the instruments, click the arrow button on the right of the 
instruments button. 



 
 
-  Building your own kit is as simple as choosing your desired instruments. 

 
Making and Saving Preset Changes 
 
If you wish to save changes to any of the presets, it must be saved in the “Save Settings” menu.  
Here you can choose which preset slot you would like save the current settings.   
 
Note: You only need to access this menu when you have modified volume or envelope settings.  Pan 
and Velocity are not affected by preset changes, and will stay when you save the instrument or multi. 
 

 
 
Note:  Please remember that after you save your settings here, the instrument or multi must also be 
saved in the Kontakt save menu.  This will result in a new user Instrument or Multi with your new 
presets. 
 

Assigning Discrete Outputs in ProTools 
 
If you have Kontakt Player open and don’t want to record Ocean Way Drums to a stereo track, you 
have the ability to route each invididual output to separate audio tracks. 
 
-  Open an instance of Kontakt Player in Pro Tools. 
 
-  Click on the   tab to bring up your Outputs.  This is where you are going to assign 
your outputs. 
 



-  If you don’t have an Ocean Way kit loaded, open the “Defaults Multi” in the “Multis” folder.  This 
will bring up the correct outputs. 
 
-  Click the  button. 
 
-  Save your session and quit Pro Tools. 
 
-  Re-open Pro Tools and your session.  You outputs in Kontakt Player are now configured with Pro 
Tools. 
 
-  Click the  button at the bottom of each audio channel to assign the correct outputs. 
 
NOTE:  The “Kick” Channel (1&2), only can be played through the track it was instantiated on.  So if 
you have Kontakt Player on an aux track, channels 1 and 2 will only be routed to that aux track.  This 
is not useful if you want to record it to an audio track. 
 
To solve this, we will simply route the “Kick” track through an empty aux output.  Click the  
button on your “Kick” track and choose 1 of the 4 auxes that you have free. (shown below) 
 

 
 
Now in Pro Tools configure your inputs from Kontakt Player. (shown below) 

 

 
 

Remember that the first channel is aux 1 because the kick is routed through it.  If you do not want it 
to say “aux 1”, simply rename your aux track in Konakt Player to a preferred name before you press 

. 
 
-  Now you have discrete outputs from Konakt Player into Pro Tools. 



Depending on your needs, you may chose to assign and print tracks in a number of ways. A 
traditional assignment would be [Kick (mono or stereo), Snare (mono or stereo), Hat (mono or 
stereo), Toms (stereo), OH (stereo), Ambience (stereo)]. You might also chose to combine the 
ambience for each individual instrument as a separate stereo event be [Kick (stereo with ambience), 
Snare (stereo with ambience), Hat (stereo with ambience), Toms (stereo with ambience), OH (stereo 
with ambience)]. This process would require multiple passes to print each stereo track in order to 
have discrete ambience per instrument. 
 

Kontakt Player 2 Optimization 
 
Because Ocean Way Drums contains a vast number of premium and configurable sounds, it can 
become taxing on lower spec computer systems.  This section will explain how to configure Kontakt 
Player 2 so you can experience the best performance from your machine. 
 
1.  Open the Kontakt options and click on the DFD tab. 
2.  Move the slider for “Amount of memory (RAM) reserved for DFD streaming voices” until the 
Maximum number of voices reaches 440.  This will allocate more RAM for Ocean Way Drums and 
take stress of your Disk. 
 

 
 
If you have a generous amount of RAM and you are still experiencing disk overload, you can override 
the instruments preload size.  Once again, this should probably not be used unless you have 2+ gigs 
of RAM.  Also, the best time to adjust this feature is when there is nothing loaded in Kontakt. 
 
3.  Click the “Override Instrument’s preload size” checkbox and move the slider to desired setting.  
100-120 kB is recommended unless you have a massive supply of memory.  
 

 
 
Optimization Tips 
 
When running Ocean Way from and external drive, change your DFD settings and use connection 
with fastest throughput. Example: Firewire 800 instead of USB.  
Use highest speed RPM hard disk available for optimal performance (especially if you are working 
with the 96k material of the Platinum Edition. Note: Platinum Edition is available on a 10,000 RPM 



hard drive with the library already installed. Upgrades are also available from Gold to Platinum. For 
more information please email: sales@sonicreality.com ) 
 

Roland V-Drum TD-20 Optimization 
 
It is important to configure your TD-20 for the optimal performance controlling the Ocean Way 
Drums V-Drum Maps.  There are three easy adjustments that you should make when you first turn 
on your TD-20 brain.  If you have a memory card, you can store the settings to avoid losing this set 
up when the unit is turned off. For more on “TD-20 Settings” please visit 
http://www.oceanwaydrums.com and/or your Roland TD-20 user’s manual.  
 
 
1.  Hi Hat Offset 
 
-  Begin by loosening the clutch of the top Hi-Hat and let it sit on the bottom Hi-Hat. 
 
-  Hold down the [KIT] button on the TD-20 and press [TRIGGER] so it will automatically set the Hi-
Hat Offset to a default position.   
 
-  Step slightly on the Hi-Hat foot pedal and tighten the clutch of the top Hi-Hat so the Hi-Hat’s top 
and bottom sit about ¼ to ½ inch apart depending on your personal taste.  When you release up off 
of the foot pedal the Hi-Hat Offset marker should rise to the top of the meter (fig. A) and when you 
close the Hi-Hat the marker should drop below the middle arrow markers on the meter signifying the 
relaxed closed position of the Hi-Hat. 
 

(A.)  
 
-  While holding the Hi-Hat foot pedal down use the cursor and value knob the move the Hi-Hat 
“Offset” value up or down (while watching the HH Offset meter) to the position where the Hi-Hat 
should be when closed with a relaxed foot hold.  When pressing down slightly harder on the foot 
pedal the meter should drop a bit lower to the entirely closed position on the meter. (fig. B) 
 
 
                                                 (B.) 
 
-  Now when you release up off the foot pedal the marker should rise to the top of the offset meter 
and when you step on the pedal it should lower towards the bottom of the meter dropping even 
lower when force is applied to the Hi-Hat foot pedal like a real Hi-Hat. 
 
2.  HH Note# Border (Hi-Hat Note Number Border) 
 



The note number transmitted when you strike the hi-hat will change depending on the amount of 
pressure on the hi-hat pedal. Hi-Hat Note Number Border allows you to adjust the pedal position at 
which the note number switches from the open hi-hat to the closed hi-hat. 
 
At the factory default value (127), the closed hi-hat note number will be transmitted only if the hi-hat 
pad is played with the pedal completely depressed. If you want this note number to be transmitted 
when the pedal is slightly raised, set this to a value such as 90. 
 
If you change the Hi-hat Note Number Border setting, the hi-hat of a pattern that was recorded onto 
the internal sequencer by playing the pads may play back in a way that is different from the actually 
recorded performance. 
 
-  Go to the main screen and press [ Setup] 
 
-  Press [F1] [MIDI] 
 
-  Press [F3] [CTL] 
 
-  Use the cursor to scroll down to [HH Note # Border] 
 
-  Play the hi-hat and adjust the number so the “closed” 
 
-  Sample triggers only when the hi-hat is shut completely 
 
-  Please take into consideration that the Hi Hat Offset and Midi Note Border together play a crucial 
role in setting up your Hi Hat, slight adjustments while playing your Hi-Hat may also be necessary for 
optimal use. 
 
-  For further information on adjusting Hi-Hat Offset and Midi Border settings please refer to your TD-
20 manual. 
 
3.  V-Drum Snare – Cross Stick Threshold (XStick Thrshld) 
 
When a PD-125/120/105/80R or RT-5S (trigger) is connected, you can determine the “cross over 
point” between the cross stick and a rim shot sounds. 
 
XStick Thrshld: 0–127 
Setting this to a higher value makes it easier to get cross stick sounds. When set to “0,” playing a 
cross stick produces the open rim shot sound. 
 
If you set the threshold to 127 you now have the option of switching between rimshot and sidestick 
sounds by pressing the F6 button on the main screen of the TD-020. 
 



Increasing the value excessively may cause the cross stick to sound as well when the open rim shot 
is played. 
 

Switching Presets via TD-20 V-Drum Module 
 
Warning: Not following these detailed TD-20 setup instructions may crash Kontakt Player 2. 
 
Switching Presets via the TD-20 is as easy as turning or pressing the Cursor or Value knob located on 
the TD-20 brain.  When using the TD-20 to change presets note that the OWD presets only cycle 
upward (1-6).  We recommend that you pick 6 different V-Drum presets that do not have “pattern” 
triggers on any of the instrument pads and create a new “Chain” of those particular presets which 
you can scroll through while using OWD’s.  Not doing so, or playing OWD’s when the TD-20 has a 
preset loaded containing midi patterns or sequences may crash Kontakt Player 2.   
 
Creating a Drum Kit Preset Chain 
 
-  Press [CHAIN] to switch Drum Kit Chain on.  [CHAIN] lights, and the “DRUM KIT CHAIN” screen 
appears. 
 

 
 
-  Press [F1 (EDIT)].  The “CHAIN EDIT” screen appears. 
 

 
 
-  Press [CURSOR (left)] to move the cursor to the chain number. 
 
-  Use [+/-] or [VALUE] to select the chain number. 
 
-  Press [CURSOR (right)] to move the cursor to the step (the order in which the drum kits will be 
selected) in the right area of the display. 
 
-  Press [CURSOR (up/down)] to select the step. 
 
-  Use [+/-] or [VALUE] to select the drum kit. 
 
-  Repeat steps 7 and 8 to create the drum kit chain. 
 



 
 
-  Press [EXIT].  The “DRUM KIT CHAIN” screen appears. 
 
Function Buttons 
 
[F1 (INSERT)] 
A step with the same kit is inserted at the cursor position, and steps after this point are moved back 
one place. 
 
[F2 (DELETE)] 
Step at the cursor position is deleted, and steps after this point are moved forward one place. 
 
[F5 (NAME)] 
You can name a drum kit chain. 
 
Note: The TD-20 will allow you to store 32 Presets in your chain.  We recommend that you use 6 to 
stay consistant with OWD’s.   
 
Now that you have your “Chain” created scroll through and make sure the “Pad Ptn” icon is not 
showing for any of those 6 presets in your Chain.  If this icon is showing (located to the immediately 
right of the preset name) for any of your chain presets the TD-20 may trigger midi patterns or 
sequences while using OWD’s.  To stop this from happening scroll to the preset in your chain that 
has the “Pad Ptn” icon.  Hit [INST] – [F3], which will take you to that particular kits “pattern” display.   
 

*If all pads are set to “OFF,” the   icon appears.* 
 
If the icon above does not appear, you may need to physically hit each V-Drum trigger and make 
sure the “Pad Pattern” selection is turned to the “Off” position.  The display will show the values for 
the trigger’s last hit.  Repeat these steps for all the presets in your Chain assuring no patterns or 
sequences are triggered while playing OWD’s.  Remember that there are multiple locations on some 
of the triggers. (ie. bell, center, and edge on the ride cymbal). 
 
Note:  The Chain Preset steps are only necessary if the Drum Kits in your TD-20 are set to have Midi 
patterns play when hitting any of your V-Drum triggers. 
 

Audio Setup and Soundcard Settings 
 
KONTAKT PLAYER 2 works in standalone mode with ASIO, MME, and DirectSound drivers on the PC, 
and CoreAudio drivers on the Macintosh. For PC users, ASIO drivers are recommended because they 



usually give the best performance. You can also use Directsound and Multimedia (also called MME), 
but expect a significant delay (called latency) between the time you play a note and the time you 
hear it. 
 
ASIO (Audio Streaming Input Output): this protocol was developed by Steinberg. It is highly 
recommended for its low latency, multi-channel audio card support, and high performance. 
 
DirectSound: Developed by Microsoft, this is a is a component of DirectX 5.0 or higher for 
Windows. How well DirectX works well depends on your sound card. If you adjust the interface for an 
acceptable amount of latency, you may hear glitches and clicks in the audio output that can only be 
fixed if you increase latency.  
 
MME (Multi Media Extension): This is the standard Windows audio driver. Most sound cards 
support this interface and work with it quite well. However, MME is even less suitable than 
DirectSound for real-time applications due to its comparatively high latency. 
 
Core Audio: This driver for MacOS X is integrated tightly into the operating system, and works with 
external soundcards, as well as the Mac's integrated audio output (known as built-in). Nowadays, 
many audio interfaces support Core Audio out of the box. They are simply "plug and play." Others, 
however, may require an additional driver to be installed. Please check your audio interface's 
documentation for further information. 
 
When using KONTAKT PLAYER 2 as a standalone application, the program communicates directly 
with your soundcard. Therefore, it is necessary to specify Audio and MIDI settings, as well as the 
preferred driver protocol.  
 
Setup for Mac and Windows machines is essentially identical, except where indicated. Note that if you 
change your soundcard, you will need to re-adjust these settings. 
 
Call up the Audio and MIDI Settings dialog from the Setup menu.  
 
You'll see two tabs: Soundcard and MIDI. 
 



 
 
Interface: Choose the fastest driver protocol supported by your sound card, which will be ASIO (for 
PC users) or CoreAudio (for Macintosh users).  
 
Note for Windows users: avoid using any drivers listed as "emulated," as they provide poorer 
performance than other drivers. For example, although DirectSound drivers generally outperform 
MME drivers, MME drivers will outperform emulated DirectSound drivers. 
 
Sample rate: The drop-down menu will display compatible sample rates for your audio interface. 
44.1kHz is the same sample rate used for CDs, and is the most universal choice. However, some 
audio interfaces offer 48kHz, 96kHz, and higher. These higher rates stress your computer more, but 
offer somewhat better high frequency response. If you are using KONTAKT PLAYER 2 in standalone 
mode, choose whichever rate you prefer.  
 
Output Device: Use ASIO written specifically for your audio interface (not "ASIO DirectX" or "ASIO 
Multimedia," unless no other choices are available), or for the Mac, Core Audio. 
 
Output Latency: This field displays the output latency. For some drivers you can adjust the latency 
individually using a fader. If a fader is not present, then you need to open the ASIO Configuration by 
pressing the ASIO Config button in the Soundcard tab and adjust the latency using the buffer size 
setting in the control panel of your audio card. Higher buffer sizes result in higher latency and vice 
versa. However, lower buffer sizes place more strain upon the computer's CPU. If a computer's CPU 
is strained too much, you may begin to hear audio artifacts such as pops and clicks. Experiment with 
the latency setting until you find the best compromise between fast response and clean audio 
performance. 
 
 
 



MIDI Setup 
 

 
 
If your MIDI interface offers multiple ins and outs, you can choose which one(s) connect to KONTAKT 
PLAYER 2. When you click on the MIDI tab, you'll see a list of all available MIDI inputs and outputs. 
Click on any "off" designation to turn it on. 
 
When used in standalone mode, KONTAKT PLAYER 2 supports MIDI input from 4 simultaneous ports, 
yielding a maximum of 64 simultaneous MIDI channels. You can access this by enabling up to four 
different incoming ports in the Input Interface section. They are assigned in order; the first enabled 
port will appear in KONTAKT PLAYER 2 as [A] 1-16, the second enabled port as [B] 1-16, and so on. 
 
The Output Interface section is used to specify where the MIDI is channeled to (similar to MIDI THRU 
ports). Typically this is not used for most sampling applications. 
 
KONTAKT PLAYER 2 is available for use in VST, DXi, and RTAS formats on the PC, and in VST, 
AudioUnit (AU), and RTAS formats on the Macintosh. 
 
Note: Some hosts include "wrappers" that convert one plug-in format to another. Try each one, as 
one may offer better performance than another. 
 
VST (Virtual Studio Technology): This cross-platform plug-in format was developed by Steinberg, 
and is used by programs such as Steinberg Cubase, Nuendo, Native Instruments Kore, and Ableton 
Live. It is one of the most common plug-in formats, and many programs are optimized to work with 
VST plug-ins. 
 
DXi (DirectX Instrument): Based on Microsoft's DirectX technology, this plug-in interface for 
software synthesizers and instruments is designed for low latency and high performance on the 
Windows platform. Cakewalk Sonar and Image Line FL Studio are the most popular hosts to support 
DXi. 



 
RTAS (Real Time Audio Suite): This format was designed by Digidesign and is used in all current 
versions of Pro Tools. Unlike traditional TDM effects that depend on using Digidesign hardware, RTAS 
plug-ins are "native," meaning that they rely on the CPU of the host computer to do their 
computations. 
 
AU (AudioUnit): This plug-in format was developed by Apple and is unique to the Macintosh 
platform. It is the most popular Macintosh plug-in format, being supported by programs such as 
MOTU's Digital Performer, Apple's Logic, Native Instruments Kore, and Ableton Live. 
 
When KONTAKT PLAYER 2 is used as a plug-in in any of these formats, it's not necessary to set up 
Audio/MIDI settings as described above for standalone use. KONTAKT PLAYER 2 operates within the 
host sequencer, automatically receiving the MIDI that the host sequencer sends to it, and sending 
back its audio output to the host sequencer. Because of this, settings regarding audio and MIDI 
interfaces as well as buffer sizes (latency) are governed by the host sequencer, not by KONTAKT 
PLAYER 2. 
 
Offline Bounce Mode: If you hear crackles or drop-outs when bouncing / freezing tracks in hosts, 
please be aware that not all hosts correctly announce this mode to their plug-ins; when Kontakt 
Player 2 is used as a plug-in, the "Offline Bounce Mode" button in the Engine tab is displayed; when 
Kontakt receives the bounce signal from the host, this will automatically turn this button on; if the 
button does not turn on automatically, this means the host does not support this feature and you 
have to enable it manually (it will turn orange). 
 
 

USING DRUMAGOG TO TRIGGER OWD IN:  
PRO TOOLS, MAC  (See below for Windows) 
 
 

1. Download/install MIDI Pipe. 
http://homepage.mac.com/nicowald/SubtleSoft 
 
2.  Launch MIDI Pipe. 
 
3.  Drag/drop an input and output from the left window to the right window. The right 
window MUST list “MIDI In” and “MIDI Out” in THAT ORDER.    
 
You can set up multiple pairs of MIDI In’s and Out’s, so that once you are working in Pro Tools 
you can use Drumagog on more than one audio track at a time.  It is recommended to make a 
MidiPipe setup of ten to twenty virtual ins and outs, following these directions, and then save in 
MidiPipe.  By saving a configuration in MidiPipe, you can then load this configuration for each new 
session. 



 
 
4.  Double-click “MIDI IN” and “MIDI OUT” in the “Pipes” list and choose the “Midi 
Pipe . . . “ option. 

 
 
Repeat steps 3 and 4 for each desired set of virtual inputs/outputs, always selecting the next 
Input or Output number.  (For your second set of virtual in/out, you will select “MidiPipe Input 2,” 
“MidiPipe Input 3” for the third, etc.) 
 
LEAVE MIDI PIPE OPEN. 

 
5. Open Pro Tools.  Start a new session or open an existing one. 
 
6.  In ProTools, go to Setup -> MIDI -> Input Devices.  Select all “MidiPipe Output” 
options.  (Note that MidiPipe reverses terminology for input/output in this case.) 
 
7.  Load the audio data you wish to replace. 
 
8.  Insert Drumagog into track.  Open the inserted instance of Drumagog. 
 
9.  In the “Advanced” tab of Drumagog, enable MIDI Out and select the “MidiPipe 
Input 1.” (see screenshot below) 



 
 
10.  Select appropriate MIDI channel. (1 by default) 
 
11.  Select the MIDI Note that corresponds to the note in Kontakt you wish to trigger - 
for example, in a bass drum track you might select “C2” to trigger one of Ocean Way Drums’ bass 
drum keys in an iMap kit. 
 
Repeat this for all tracks you wish to replace with Drumagog, each time choosing the next 
consecutive MidiPipe Input (MidiPipe Input 2 for the second instance of Drumagog, MidiPipe Input 
3 for the third, etc.) 
 
By adjusting the knobs on the “Main” tab of Drumagog you can further control Drumagog’s 
interpretation of the audio data.  The sensitivity and resolution settings can be set visually by 
selecting “Visual” at the bottom right corner of the “Main” tab.  For instruments mic’d directly with 
sufficient isolation, the settings will be fairly cut and dry and easily manipulated.  However, for 



instruments mic’d with insufficient isolation, such as overhead mics, the results will be less 
accurate and consequently harder to manipulate.  

 
Also note that, while triggering Kontakt via MIDI, Drumagog will also replace the selected track 
with the chosen (or default) audio sample from the Drumagog library.  To avoid hearing this, 
completely turn down the Output knob in the “Main” tab of each Drumagog instance. 
 
12. Set up an instrument track in Pro Tools.  Insert Ocean Way Drums into this track.  In 
Kontakt/Ocean Way Drums, load your desired kit, preset, etc. 
 
13.  Press play.  This will trigger Ocean Way Drums. 

 
To record real-time replacement, send and record the instrument track to a new stereo audio 
track. 
 
To manually edit Drumagog’s output, record Ocean Way Drums’ output into the instrument track.  
From there, using Pro Tools’ editing tools, notes can be deleted, moved, added, or embellished.  
This instrument track can later be bussed to a stereo audio track for audio recording. 

 
 
 

USING DRUMAGOG TO TRIGGER OWD IN: 
PRO TOOLS, WINDOWS 
 
 
1.  Download/install MIDI-OX and the MIDI Yoke plug-in. 
http://www.midiox.com 
If you have Windows XP, no additional instructions are needed.  If you have NT/98/ME/etc., follow 
the directions on the MidiOX website.  If you have Vista, disable the User Access Control (UAC) by 
following the following instructions. 
 1.  Download MIDI Yoke installer 
 2.  Run MSCONFIG from the Run menu 
 3.  Go to the “Tools” menu and select “Disable UAC” 
 4.  Press “Launch” and close the window.  Restart. 

Midi-OX will be installed as a standalone program, MIDI Yoke is a plug-in (and therefore will not be 
seen on your desktop, start menu, etc.) 
 
Restart your computer after installation of both of these components. 
 
2.  Launch MIDI-OX. 
 
3.  In MIDI-OX, go to Options -> MIDI Devices.  Double-click the same number of Inputs 
and Outputs so that they’re added to the “Port Mapping” and “Port Map Objects” menus 



(see screenshot below).  It is recommended that you set up ten to twenty sets of in/out 
so that you will have ample ports to work with.  

 
After setting up your desired virtual inputs/outputs, you can save the configuration as a preset, which 
can then be loaded as a template for each new session. 
 
LEAVE MIDI-OX OPEN. 
 
4.  Open Pro Tools.  Start a new session or open an existing one. 
 
5.  In Pro Tools, go to Setup -> MIDI -> Input Devices.  Select all MIDI Yoke inputs. 
 
6.  Load the audio data you wish to replace. 
 
7.  Insert Drumagog into track.  Open the inserted instance of Drumagog. 
 
8.  In the “Advanced” tab of Drumagog, enable MIDI Out and select the “Out To Midi 
Yoke: 1” MIDI Port.   
 
9.  Select appropriate MIDI channel.  (1 by default) 
 



10.  Select the MIDI Note that corresponds to the note in Kontakt you wish to trigger – 
for example, in a bass drum track you might select “C2” to trigger one of Ocean Way Drums’ bass 
drum keys in an I-Map kit. (See screenshot below) 
 

 
 

Repeat this for all tracks you wish to replace with Drumagog, each time choosing the next 
consecutive MIDI-OX output (Out To Midi Yoke: 2 for the second instance of Drumagog, Out To Midi 
Yoke: 3 for the third, etc.) 
 
By adjusting the knobs on the “Main” tab of Drumagog you can further control Drumagog’s 
interpretation of the audio data.  The sensitivity and resolution settings can be set visually by 
selecting “Visual” at the bottom right corner of the “Main” tab.  For instruments mic’d directly with 
sufficient isolation, the settings will be fairly cut and dry and easily manipulated.  However, for 
instruments mic’d with insufficient isolation, such as overhead mics, the results will be less accurate 
and consequently harder to manipulate. 
 



Also note that, while triggering Kontakt via MIDI, Drumagog will also replace the selected track with 
the chosen (or default) audio sample from the Drumagog library.  To avoid hearing this, completely 
turn down the Output knob in the “Main” tab of each Drumagog instance. 
 
11.  Set up an instrument track in Pro Tools.  Insert Ocean Way Drums into this track.  In 
Kontakt/Ocean Way Drums, load your desired kit, preset, etc. 
 
12.  Press play.  This will trigger Ocean Way Drums. 
 
To record real-time audio replacement, send and record the instrument track to a new stereo audio 
track. 
 
To manually edit Drumagog’s output, record Ocean Way Drums’ output into the instrument track as 
MIDI data.  From there, using Pro Tools’ editing tools, notes can be deleted, moved, added, or 
embellished.  This instrument track can later be bussed to a stereo audio track for audio recording. 
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Ocean Way Drums: FAQ 
 
Q: Why is my copy of Ocean Way Drums saying "There was an error trying to acquire a 
license for this patch! Error Message: This copy is not yet activated. Please use the 
Service Center to activate" when I try to load a patch? 
 
A: This is because you’ve only entered your serial number and have not yet registered your product 
with Native Instruments through the Service Center.  After 30 days of use with only a serial number 
OWD will no longer open until registered.  Use Service Center, which should have been installed off 
of OWD disc #1 to create a Native Instruments account and register. 
 
 
 
 
Q: When I try to load a Multi or Instrument Kontakt is saying it can't find files. Why are 
files missing? 
 
A: You are missing a particular .NKX file which contains all the files needed to load the Multi's or 
Instruments.  First make sure you have 21 .NKX files in your Samples folder (1-21).  Next be sure 
sitting along side your Instruments, Multi's and Samples folders you have another .NKX called "Ocean 
Way Drums Gold_info.nkx" or "Ocean Way Drums Platinum_info.nkx".  This file must be in this 
location for OWD Multi's and Instruments to load properly.  If any of these files are missing simply 
locate them on OWD disc's 1-6 and copy them to the appropriate location. 
 
 
 
Q: When I try to save a User Patch into the User Patch folder I'm not seeing the newly 
saved patch. Why? 
 
A:  First, make sure you are saving your patches in the correct place.  User patches are saved in the 
Kontakt Player 2 application folder in “UserPatches”.  Once you have saved them in the Instrument or 
Multis folder, open up Kontakt Player and click on the options tab.  Click on the “Load” tab and note 
the “Library Path” field at the bottom of the window.  If it is not directed to the “UserPatches” folder, 
use the browse button to select the correct folder. 
 
 
 
Q: When using OWD with the V-Drum kit, how can I change presets from in front of my 
computer without having to hit the + and - buttons on the V-Drum TD-20 brain? 
 
A: The preset changing function is controlled by a CC.  This CC can be assigned to any midi controller 
that can send CC messages.  In most cases it is easiest to use a midi controller with easily assignable 
knobs.  Simply assign a particular knob to control CC0 (CC ZERO) to quickly toggle through OWD V-
Drum presets. 



 
Q: How do I configure the OWD outputs for use in Protools? 
 
A:   
-  Load your Protools Session. 
-  Open an instance of Kontakt Player if one is not already available.   
-  Load an Ocean Way Kit, or simply drag in the “Default Outputs” multi into KP2.  This will create the 
correct outputs.   
-  Click the outputs tab at the top of the screen if your Outputs are not currently being displayed.   
-  In the Outputs window, click the red box labeled “Make Default”.   
-  Save your session if needed, and close Pro Tools completely.  
-  Reopen your session and open Kontakt Player.   
-  Click the “config” button below each channel in your outputs and assign the physical outs to their 
corresponding output.  Example:  Assign your Hat channel to physical output “Hat”.   
-  Now when you select the input of your audio track, you can choose the individual outputs of 
Kontakt Player. 
 
 
 
Q: How do I configure the OWD outputs for use in Logic? 
 
A:   
-  Load your Logic Session. 
-  Open an instance of Kontakt Player if one is not already available.   
-  Load an Ocean Way Kit, or simply drag in the “Default Outputs” multi into KP2.  This will create the 
correct outputs.   
-  Click the outputs tab at the top of the screen if your Outputs are not currently being displayed.   
-  In the Outputs window, click the red box labeled “Make Default”.   
-  Save your session if needed, and close Logic completely.  
-  Reopen your session and open Kontakt Player.   
-  Click the “config” button below each channel in your outputs and assign the physical outs to their 
corresponding output.  Example:  Assign your Hat channel to physical output “Hat”.   
 
- Create 6 Aux Tracks and 6 Audio Tracks  
- Go to the input of each aux and select the individual outputs of Kontakt Player.  Example: 
“KontaktPla 3-4”.  
- Set the Outputs of each Aux Track to a discrete bus. 
- To route the signal to the audio tracks, select the corresponding bus on the input of each audio 
track. 

 
 
 
 

 



Q: How do I configure the OWD outputs for use in Digital Performer? 
 
A:   
-  Load your DP session. 
-  Open an instance of Kontakt Player if one is not already available.   
-  Load an Ocean Way Kit, or simply drag in the “Default Outputs” multi into KP2.  This will create the 
correct outputs.   
-  Click the outputs tab at the top of the screen if your Outputs are not currently being displayed.   
-  In the Outputs window, click the red box labeled “Make Default”.   
-  Save your session if needed, and close Pro Tools completely.  
-  Reopen your session and open Kontakt Player.   
-  Click the “config” button below each channel in your outputs and assign the physical outs to their 
corresponding output.  Example:  Assign your Hat channel to physical output “Hat”.   
-  Now when you select the input of your audio track, you can choose the individual outputs of 
Kontakt Player. 
 
 

 
Q: Do I have to install all of the content for OWD to work properly? 
 
A: Yes.  Do to the nature of the .nkx files, all content must be installed to ensure the ability to load 
complete kits. 
 
 
 
 
Q:  Do I have to use Kontakt Player with Ocean Way Drums? 
 
A:  You can use OWD within Native Instruments Kontakt 2 or 3 as well.  The interface is virtually 
identical to that of Kontakt Player.  OWD will not work with any other sampler. 

 
 

 
 

 
 

For more information please visit and join up at: 
http://www.oceanwaydrums.com 

 
Sonic Reality 

http://www.sonicreality.com 
 

Ocean Way Studios 
http://www.oceanwayrecording.com 



 
 

 

 


